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Setting up STRand software. 
 
A. Downloading and installing 
 
The most recent version of STRand is on the UC Davis VGL Home 
Page at http://www.vgl.ucdavis.edu/informatics/STRand/  
 
B. Setting up STRand once installed. 
The updated version of this manual assumes that users do not need to 
create a matrix file or dye standards for their machine.  If that 
assumption is incorrect and you need to configure your instrument 
manually, refer to the original version of the instruction manual for the 
information. 

STRand configuration files are stored in an Access database 
found in the STRand directory. Microsoft Access is not needed for 
normal use of the program. However, you may wish to work with the 
files directly if you run into a bug.  
 Note: Updating the STRand preferences and configuration is 
an iterative process – in other words, you usually need to exit the 
program and restart it for the changes that you have made to take 
effect in the STRand program.   
 
1. Computer environment Change your display settings (if needed) 
to at least 1280 x 768 resolution – lower resolution can result in 
program difficulties.   
 
2. Start STRand, and choose a user name  
 
3. Create a gel group for your data (or one for each set of data, 
as this will keep things organized) 

- Tools > Manage > Gel groups 
- Add 
- Enter the name for each unique gel group (or folder of 

*.fsa files that come off a capillary sequencer) that 
you wish to keep separate in your analysis 

- Done 
 

 
** Note: We’ll say it again: updates are iterative, so the gel groups 
window in the lower right corner of the screen will not show your new 
gel groups until you have exited from STRand and then restarted the 
program from the newly modified database.  ** 
 
4. Verify that your sequencer is identified 

Tools > Preferences 

Here you can set the color of the traces (dye labels) that you prefer, 
the default path to the folders in which you keep your gel files and so 
on.  The important things to set are: 
a) Default configuration – this must match the general sequencer 
platform (even if the exact model number is not available) and the 
complete dye set that you are using.  In our case, we have an ABI 
3130XL which is not included in the default list, but the ABI 3700 
FVNPL (6-FAM, VIC, NED, PET & LIZ) option is equivalent and 
works just fine for analyses. 
b) Default size standard – this should match the size standard that you 
are using to score your alleles, but can be changed in the test that is 
applied. 
c) Default test – this is the set of locus rules and the size standard that 
you want applied to your samples in order to score the allelic sizes 
(once you set locus rules – Pg 4).   
 
The rest of the settings under preferences can be considered 
personal preferences, but these three settings must generally be set 
correctly in order to score your data.  For example, you can 
specify the directory from your data will be imported, and where 
you will want results exported. (These can be the same directory, 
but they don’t have to be).  
 
8. EXIT STRand (we will want all the changes we have made to 
take effect) 
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Importing a gel from the sequencer to STRand 
 
1. Start STRand.  
 
2. Add sample files.  
File > Add Sample Files  
Use the explorer window to navigate to the folder in which your 
samples from the sequencer are stored on your hard drive. It is 
important to include only sample files from the sequencer in that 
folder because other files can confuse STRand.   
 

 
 
Double-check that the instrument matches your dye set, and set the run 
name to something that will make sense to you a year from now when 
you have 100 gels to go through in order to find this one.  Click the 
Append Tube and Autonumber boxes to include all the samples in 
your folder and automatically create a line-up (see Page 7) for you 
(otherwise you will get unnamed samples that stop at the same number 
of samples as your machine has capillaries).  The Starting Scan allows 
you to cut off the front of each sample.  The default starting scan of 

3000 is sufficient to cut off the unincorporated primer fronts and 
generally gives a cleaner electropherogram, but can be reduced if very 
small fragments need to be scored.  To be safe, this value should 
initially be set to 0 and increased to an appropriate starting point after 
looking at a number of gels.  Generally, a value close to 3000 is about 
right.  Click OK when ready. 
 
3. Check the settings.  Double click on the name of the gel (run 
name) in the gel queue to check that the configuration shown is the one 
you expect (instrument configuration and dye set). Change to the 
correct one if needed.  This is also where you can delete the gel results 
if you decide that the calling was incorrect and you want to start over 
(e.g., with a new configuration). 
 
4. Analyze the gel.  Click on the run name in your gel queue window 
to highlight it, and click on the DNA Type radio button to analyze the 
gel files.  This may take a moment with many lanes of data, but you 
should see the progress moving along steadily on the screen.   
 
5. Check that the number of samples matches your expectation 
– if you ran a 96-well plate, but only have 16 samples here or don’t 
have any names associated with your samples, you most likely 
forgot to check the Append Tube and Autonumber boxes when 
adding sample files.  Also, check to make sure that the spacing on 
the alleles is consistent and that the marker names match your locus 
rules that you have set (see below).  Any of these being off is a sign 
that something has gone wrong with the automatic gel analysis or 
you have made an error in the configuration when adding your 
sample files. 
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Set up locus rules for your gel analysis 
You will want the lanes on your gels to be scored according to the 
appropriate locus rules that you have determined.  If you are working 
with multiple species, or multiple people are using the same computer, 
you will want unique locus rules for automatic size calling of each 
locus.  
 
1. Tools > Loci rules 
Click the Add Test button 
Enter the name for the species or analysis that you will perform on 
your gels, and click OK. 
 
2. Add locus rules 
Select the new test name and click on Add Locus 

 
This is simply an example – locus rules can be set using the locus 
rule tool (pictured here) or programmed manually in the locus rules 
window.  The Process is covered in detail on Page 10, and virtually 
everyone uses the locus rule tool because it makes life easy.  
Repeat this process for each of the loci that you will want to score 
within this test group (e.g., a species primer set or a specific 
analysis). 

 
3. EXIT STRand (we will want to incorporate the changes we just 
made) 
 
4. Restart STRand 
 
5. Reset preferences 
Tools > preferences 
Make sure that the value for “Default configuration” includes the full 
range of dyes for which you just defined locus rules, and change it to 
the appropriate instrument and dye set configuration if it is not 
already there.  Click on the value for “Default test” and change it to 
the test you just named that includes your specific locus rules that 
you want applied to your gels and the size standard that you are 
using. 
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Once you have created your 
own gel group you can then 
add and analyze your gels: 

g the 
st  rest 

y  
nee

2. 

and a run file. The gel file contains 
the gel image that you will want to 
analyze.) 

3. As you are selecting a gel to add 
you also want to select the 
appropriate instrument that your gel 
was run on (e.g. ABI 377 A 96 can 
be used if your gel was run on an 
ABI 377 and has 96 lanes). You 
may need to manually add a matrix 
file and instrument configuration if 
none of the available instruments fit 
your needs. 

4. Once you have your gel selected, 
click ‘Add’ and your gel should 
automatically be added to the Gel 
Queue window. 

 
If you are using a capillary sequencer, 
your ‘gels’ are added by followin
in ructions on Page 3, so skip the
of this page…   
If ou are using a slab gel machine, you

d to add your gels to your new gel 
group as follows: 
 
1. Select your gel group in the lower 

right hand corner of the Gel Queue. 
If you have just created your gel 
group you should not see any pre-
existing gels in your folder. 
Click ‘Add Gels’ and select the 
file that contains your gel. (The 
ABI Sequencer outputs three files 
after its run; a gel file, a log file, 
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LANE (left column)- To select all 
click on ‘Lane’ and the whole colum

highlighted. To select specific sa
ld the shift button while you select 
mples. 
AMPLE NAME (middle column)- En
ur sample names here. The # of samples 

you name should correspond to the #
lanes you select in the next step. 
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mers (or primer group) you can creat
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ier. In this column select the primer 
ups used for each sample. In order to

ange more than one sample at a time 
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Again, if you are using a capillary ma
no need to find lanes on your gel, so 
this entire page.  If however, you are using 
system, STRand needs to know where each sa
is located on the gel, and the find lanes pro
1. With your gel highlighted in the Gel Qu

window click ‘Find Lanes’ and a picture
your gel should appear. (If no pictur
in the Lane Find window check that the
are trying to analyze is the correct gel i
file and not the ABI run file.) 

2. To select the lanes you want to view 
click in the middle of each single
holding the shift key. As you d
numbered line should appear; #1 
to the first lane you selected, #2
and so on. The number of lanes that yo
should correspond to the # of samples i
lineup. To delete a lane, hold the shift k
right-clicking on one of the nodes (whit

3. Adjust the lines so that they lie in the m
the corresponding lane by moving you
over either end joint of the lane until a 
¤ arrow appears. Click once while m
arrow in the desired direction. (To 
readings make sure that your line pas
through all of the size standards (red 
that lane.) 

4. You can also adjust the top (red line) 
(green line ) parameters by holding the 
line until a up and down arrow appears. 
drop so that the bottom line (green) cuts
of junk and primer dimers (if you fail t
may have problems getting STRand to read 
standards correctly) but leaves at least 1 
erably 2) size standard peak(s) between it a
lowest band you intend to size. The top lin
should leave at least 2 size standard peaks 
last allele for best accuracy in size calling. 

5. If you can not get the line to match up with your lane by just adjusting the end it is possible to adjust 
along the length of the lane as well. To reshape the line set the cursor where you would like the line to 
bend and hold the control key while double clicking. A new joint will appear along with a two-way 
arrow that can be moved either right or left. You can also delete nodes by holding the control key and 
right clicking with your mouse. 

6. The left box of the gel file window allows you to view the vertical slice of gel corresponding to the 
highlighted line (e.g.: lane 15 is selected and we can see that it passes cleanly through all the size 
standards and a band ~120bp). 

7. Use the Lane Find Settings Window to change the settings of your gel picture. Adjust the brightness by 
moving the tab and clicking “Apply”. To automatically use the “Find Lanes” function adjust the height 
and delta to specify how many scan lines represent a real band and the least amount of scan lines 
between two bands, respectively (we actually find it easier to just find all the lanes manually like 
explained in steps 2-5). Use the “Scale Image” functions to stretch or shrink the gel picture for ease of 
viewing when selecting lanes. 
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With your gel highlighted in the Gel 
Queue window click ‘DNA Type’ and an 
electropherogram of your gel should 
appear. When your gel data is loading the 
program may say, “some lane data 
missing”. Just disregard and click ‘OK’. 

his happens when you have less lanes 
ected than what your matrix allows, e.g. 
y 90 samples but 96 wells allowed) 

when you first open ‘DNA Type’ and in 
the Gel Image box it says, “No Standards 
Found”, you may need to reanalyze the 

. 
analyzing the Lane- you can reanalyze 
t the lane itself by clicking ‘Lane’ then 
nalyze’ on the toolbar. Changes will 
ppen immediately. 
analyzing the Gel– If all the lanes 
uire reanalyzing it may be easier to just 

reanalyze the entire gel. On the toolbar 
click ‘Window’ then ‘Gel Queue’. Double 

ck on your gel and a ‘Gel Settings’ win-
w should pop up. It should not be 
cessary unless you have changed 
mething with rounding or loci rules, but 
you need to, click ‘Delete Results’ then 

‘Yes’ and reenter the Electropherogram by 
clicking ‘DNA Type’ (or ‘Window’, ‘Your 
Gel File’). Once you are back into the 
Electropherogram on the toolbar click 
‘Gel’ and ‘Analyze’. You will lose any 
previous data, but if this is the first time 
you are analyzing your gel you should 
have no data yet to lose. 
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g your Standards - Once the program recognizes your standards you may want to make sure the 
orrespond to the correct bp size.  The simplest quality check is to make sure that the spacing is 

nsis ent and covers the appropriate size range (unlike the image above).  If not, in the ‘Peaks’ box 
ghli ht each standard separately (like in the example next page) to make sure it corresponds to the correct 

n the electropherogram. If a peak shows up that is not a standard, but is being read as one, you can 
ock he program from recognizing it by right clicking in the left column of the ‘Peaks’ box. 

  If when you open ‘DNA Type’ and the Gel Image box says “Alleles before first standard” you may 
o readjust your included scans in the initial import of files (Page 3) so that each lane includes your 
rds as well as all your amplification bands. 
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The Electropherogram Window: 
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corresponds to GeneScan standards, and in this example the 300bp standard is highlighted both in the 
‘Peaks’ box as well as on the electropherogram.  Sometimes the program will read peaks that are a result 
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8. in the DNA Type box. The range of the ruler 
corresponds to the range set in the Locus Rules sele ed when creating the Lineup (see next section). 

 
1. In the ‘Samples’ column select then s

/lane you would like to view. Once you 
have it selected, the Electropherogram
display the results for that specific lane. 
‘Graph Controls’ allow you to toggle each
color marker on or off by simply double 
clicking. The X and Y zoom will allow 
you to stretch a selected peak horizontally 
or vertically. This box also contains a 
legend for the color-coding for each dye 
labeled primer (e.g. TAMRA is 
represented by black peaks). ‘Gel Image’ 
shows the actual gel and the lane that yo
are currently viewing. 

3. The ‘DNA Type’ box allows you to view 
your data according to the Loci Rules 
specified in the Lineu
corresponds to a primer, and the prog
will automatically estimate the size of any 
peaks within the range and color specifi
for that primer (see below to set up Loci 
Rules). In this example primer ASB2 
evaluates any FAM colored peaks between
222-258bp. The blue peak that is 
highlighted is a heterozygote with two 
peaks, one at 246 and one at 248. Type 
corresponds to either the letter or size 
designation. Pressing ‘Z’ or BACKSPACE 
moves you back one marker. Selecting a 
peak and pressing ‘V’ changes the poin
to a wedge that you can click on the pea
and split it into two peaks (some strong 
alleles with a weak adjacent allele can be
detected as a single fat pe
The ‘Peaks’ box displays

of pull-up or stutter that you want to disregard. These peaks can be toggled on or off by right clicking in 
e left column of the ‘Peaks’ box. 
e Gel Image box shows a virtual gel and the lane that you are currently viewing - use the RETURN key

 move down from one sample to the next in the Samples box. 
se the SPACEBAR to move between markers of one sample on both the Electropherogram and DNA 

Type box. 
The x-axis of the Electropherogram corresponds to the bp length and the y-axis corresponds to the 

ak scan height. 
The ruler corresponds the specific marker highlighted 

nd color label ct
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Setting up Locus Rules: 
 
1. In either the electropherogram window 

 
 

3.

4.

5.
es of your ampli-
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or the Gel Queue window click ‘Tools’ 
and then ‘Loci Rules’. Maximize the 
window so that you can see the ‘Add 
Test’ and ‘Add Locus’ Buttons. 

2. To add a new group of primers click ‘Add
Test’ and enter the name of your primer
group. 

 With the name of your primer group 
highlighted click ‘Add Locus’ and a 
’New Locus’ box will appear. 

 Name – fill in the name of your new 
locus (or primer). 

 Range – from min to max fill in the 
expected alleles siz
cation. Estimate a range based on a 
known peak size if you do not know t
range – you can always change it later 
when you know the range. 

 Example allele – enter the ‘standard’ 
allele to determine rounding of your 
allele sizes to odd or even (the most 
common allele is a good choice). 

 Use Letters – if checked this command 
assigns letters to each allele size
122bp-A, 124bp-B, 126bp-C…) 

 Repeat Unit – corresponds to the ex-
pected repeat size in bp (e.g. CACACA 
is a 2 unit repeat, CATCATCAT, is a 3 
unit repeat) 

 Color – choose the color that your new 
locus primer is tagged with. 

. Repeat steps 3 through 9 until all your 
loci have been added. 

 You can evaluate several primers within one group so add as many loci as you need to your primer 
group. (This is most effective if you make new primer groups for each multiplex PCR being 
evaluated.) Once you have finished setting up each locus within your primer group, close this 
window and your Loci Rules will be ready to use. 

∗ If you select the appropriate test (primer group) when first importing your gel files, it will automatically 
be applied when you click DNA Type to analyze your gel.   

∗ If you ever need to adjust your Loci Rules, you will have to exit and re-enter for any changes to take 
place. See the next page for information on adjusting a pre-existing locus. 

∗ The list of alleles control which alleles are listed in the chooser lines on the Electropherogram and
what labels are assigned to each of the called alleles. 
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Tests – lists all of the existing primer 
groups or locus rule sets. 
Size Standard – make sure the size

standard selected for the locus cor-
responds the standards used during 
ABI sequencing run. 
Loci – 

primer group. Highlight a loci of 
interest to view its parameters. 
Channel – corresponds to th

designation of that locus/primer. Blue
(e.g., 6-FAM
(e.g., VIC)-Channel 2 Yellow 
(e.g., NED)-Channel 3 Red (e.g.,
PET)-Channel 4 
Purple (e.g., LIZ) – Channel 5 

Allele Info - In the ‘Allele Info’ box 
are the expected sizes of the se
for the primer from the smallest to the
largest, spacing between the numbers
a comma, then a space, then semi-
colon (e.g. 
122, ;124, ;126, ; and so on). If you 
input even numbers the machine will 
round even, and odd numbers will 
round odd. In this example, we 
expected an even di-nucleotide repeat 
so we can get away with inputing the 
sequence siz

6. Analysis Script, Rounding Script, 
and Globals - The Analysis
Rounding Script boxes contain pa-
rameters for calling and

* 

ed when creating the locus). 
e Up, Move Down - The ‘Move Up’ and ‘Move Down’ buttons will change the order of the pri
in a primer group. The way that they are ordered in L

Ele tropherogram window during your analysis. 
u ver need to make adjustments of your locus parameters, you can do it manually by changing the 

nfo mation in Boxes 1-7. For example, say in the primer group and locus above, your max range expanded
0 p and the color of your primer was actually green not yellow. First in the Allele Info box add sizes 14

p50 aces with a comma, space (or letter designation) and a semi-colon (142,L;144,M;146,N;148,O;150,
ex n the Globals box change RangeMax to be 150, M (your ‘standard’ allele to set binning) to be 14

Plane (same as Channel) to 2. Lastly change Channel box to
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Basic Export of Allele Calling Data: 
 
1. You can use the built-in ResultViewer program (see Page 15) to manage your data, or you can do a simple 

export. 
2. While in the Electropherogram, on the Toolbar click ‘File’, ‘Export Data’. 

 tell you how many of your lanes have problems (because of no size 
is 
el 

ur data 

the Electropherogram: 

The program, based on the Locus Rules, 
ill call any ‘normal’ alleles in the locus 
nge. For example, in the picture on the 
ght, locus ASB 2 is sel

range ruler is visible. The program has 
called this peak a heterozygote with a 2

d 248 allele. But if you believe t
automated calling is in error, you can do

veral things: 

ing a peak the program has 
 – If you see a peak, but it does 

gister in the Peaks 
lly select it by holding shift, 

clicking and dragging across the top of 
This will add a size standard peak 

hen no locus is selected or when a 
cus is selected a peak in the color of 
at locus. 
Marking or
 existing peak – If you see a peak an

is not registering as an allele of the 
lected locus, right click on it and its 
e should appear in the DNA typ
so use right click to unselect a wrongly
lled allele. 
Changing the size of a called peak – standards, invalid alleles, more than two alleles, etc. — you should have already gotten a warning about th

when working with the files on your gel image) and mark them with an asterisk. You can choose to canc
(i.e., go back and fix those lanes) or ignore (continue). If you do not get this message, all of yo

3. The program will automatically

If you think the program is calling 
ak the wrong size you can chan
 clicking on the peak and th
cking on the size that you think 
ould be on the drop down dotted lin
 range ruler. 

 checks out properly. 
4. If you choose to continue you will need to pick the number of lanes to export, generally you want to do 

all of them, but if you want the data from the first 10 lanes, you can specify that. 
5. An Export Results box will then appear and you must specify where you want your data file to go, and 

name it. Once it has been saved you can view or print the results by opening the file in Excel. 
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V  
 
In order to vi le that is located in several gels in a gel folder, you can use ‘Open Case’ 

er: 

1. In the Gel Queue window click ‘Open Case’ and a window (like one below) will appear. 
 you want to view and click ‘Add’. The Sample List will 

ple. Use ‘Remove’ by selecting any samples that you do 
. 

K’ and an Electropherogram will appear that only contains the 

ne Electropherogram: 

have two lanes in a gel that you want to view one on top of the other you can use the Multi-Lane Electropherogram function: 

w’ and ‘Multi-Lane Electropherogram’. A Lane Selection box should pop up. 
 under the lanes of interest select the dye color of the peaks that you want to superimpose. (In this example I want to see  

es 2, 7 and 10.) Click ‘OK’ and the MultiLane box will appear. 
lists all the dye colors possible for the lanes that were selected. The dye colors designated by a full colored box are shown, 
 selected for the same dye color will be represented by a different shade for ease of viewing (e.g. since only blue was 

e shown as blue for lane 2, purple for lane 7, and pink for lane 10). The X and Y switches will shrink or stretch the image 
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ResultViewer  

Tools > ResultViewer 

The ResultViewer window will launch and you have the option to examine results from a Serial selection of lanes, a 
single sample, or an entire gel at once.  Type in the name of the gel from your Gel Queue and click Add.  Highlight the 

 at the bottom of the window.  This will generate a table with the sample 
cross columns.  The first allele is listed in the column labeled with the 
 listed in the following column.  Samples highlighted in red have an 

d missing data is represented by a zero (0) entry.  Scrolling the 
-up widow of the metadata underlying that calling (gel, lane, locus, 
he DNA Type window and locate the sample to double-check the 

calling. 

table can then be saved directly as an Excel data file (*.dat) or as a text file for import into wh er 
ogram is preferred. 
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Upgrading STRand to the latest version without overwriting your existing data: 
If you want to upgrade your working version of STRand to the latest version, you can find your STR.mdb 
file (usually in c:\program files\strand\) and copy it to a temporary folder. Download and install the latest 
version of STRand (as outlined at the beginning of the manual) and then copy your STR.mdb file back 
into the STRand folder, overwriting the one you just installed. This process will transfer all of your 
existing data into the new version of the software. 


